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COURSE OBJECTIVES 

By the end of this course you will be able to 

 Accurately create a specified Contact Group, without referring to notes. 

 Correctly create a signature that incorporates a specified Electronic Business Card, referring to 

notes if necessary. 

 Correctly create a specified rule, referring to notes if necessary. 

 Briefly describe how to set up an out-of-office message. 

 Correctly modify a specified message view, referring to notes if necessary. 

 Correctly create a new colour category, without referring to notes. 

 Accurately assign colour categories to contacts, referring to notes if necessary. 

 Briefly describe how to set follow-up flags. 

 Briefly describe how to create an additional calendar. 

 Correctly carry out a specified search, referring to notes if necessary. 
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MODULE 1 – LISTS AND CONTROLLING MESSAGES  

OBJECTIVES 

At the end of this section you will be able to: 

 Accurately create a specified Contact Group, without referring to notes. 

 Correctly create a signature that incorporates a specified Electronic Business Card, referring to 

notes if necessary. 

 Correctly create a specified rule, referring to notes if necessary. 

 Briefly describe how to set up an out-of-office message. 

CONTACT GROUPS 

If you frequently email the same group of recipients, a contact group, or distribution list, can be a real 

time saver. Instead of having to add each individual contact one-at-a-time, you simply add the contact 

group to your email and have included all of those contacts in one step. 

To create a contact group 

1. On the Home tab of the Ribbon, in the Send/Receive group, click on the New Items 

button, then select More Items and select Contact Group. Alternatively press 

C+S+L.  A blank Contact Group will be displayed. 

2. In the Name textbox, type a name for your group. 

3. To add members from existing contacts, in the Members group of the Ribbon, click on 

the Add Members button. Choose to add members using one of the following options: 

 Outlook Contacts or an Address Book - the Select Members window will be 

displayed. In the Address Book drop-down list, select the address book that 

contains the e-mail addresses that you want to include in your Contact Group.  

a) Double-click on each contact you wish to add to the group, they will 

appear in the Members textbox at the bottom of the dialog, or type email 

addresses directly in the Members textbox. Each address will be separated 

by a semi-colon. 

b) When you have selected all of the contacts you wish to add to the contact 

group, click on OK. 

  New E-mail Contacts. The Add new Member dialog is displayed as shown here. 

Complete the boxes in the 

dialog, and if you want to 

add this person to your 

contacts at the same time 

ensure you tick the Add to 

Contacts check box. Click 

on OK to close the dialog. 

Note: To save lots of form filling, if 

you have a list of email addresses 

with individual addresses 

separated by a semi-colon, copy 

the list to the clipboard and use the Outlook Contacts option (step 3 above). You can 

click in the Member textbox and paste the list. 
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4. In the Contact Group window, and in the Actions group of the Ribbon, click on the Save 

& Close button. 

 The newly created contact group will now appear in your address book and contacts. A contact group 

can be differentiated from an individual's entry by looking at the icon and the name/details are also 

emboldened (not in all views).  

 

To edit a contact group 

1. In People double-click on the Contact Group name to edit. 

2. Make any changes then in the Actions group of the Ribbon, then click on Save & Close. 

To delete a contact group 

1. In People click on the Contact Group name to select it. 

2. Press D and confirm your action. 

Note: You do not delete the contacts within the group if they are separate entries in Contacts; 

however, if you group contains email addresses that are not individual entries elsewhere, these 

email addresses will be lost. 

 

SIGNATURES, BUSINESS CARDS AND STATIONERY 

Signatures 

An e-mail signature consists of text or pictures that are automatically added to the end of an outgoing e-

mail message. You can create as many signatures as you want, so that you can have signatures for a 

variety of purposes, such as business or personal messages. You can format the text in the signatures 

that you create by using colours and fonts. You can also add other elements to the signature, such as 

your Electronic Business Card, pictures, or logos. 

While a signature can be created during the creation of a message, it is best to set up signatures 

beforehand. 

To create a signature 

1. Either, 

 Select the File tab in the Ribbon then click on Options. Select the Mail category in the 

left-hand panel and in the Compose messages section, click on the Signatures button. 

 Alternatively, in a new mail message select the Message tab of the Ribbon, and in the 

Include group click on the Signature button. Then select Signatures... from the drop-

down menu. 

2.  The Signatures and Stationery dialog is displayed. 

Time for Exercise 1 
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3. On the E-mail Signature tab, click on the New button. 

4. Type a descriptive name for the signature (such as Fred Work or Ann Personal), and then 

click on OK. You are then returned to the Signatures and Stationery dialog. 

5. In the Edit Signature box in the lower half of the form, type the text that you want to 

include in the signature.  The text can be formatted using the buttons above the text box. 

Note:    These formatting options can be set even if you use plain text as your message 

format. The formatting will not be visible in your outgoing messages, however it will be 

visible to recipients if you change the format to HTML or .rtf message formats. 

6. To add an Electronic Business Card (see later in this manual), click in the text where you 

want the card to appear then click on Business Card, and then select a contact in the 

Filed As list. Then click on OK. 

7. To add a picture, click in the text where you want the picture to appear, 

click on the Insert Picture button, browse to an image, click to select 

it, and then click Insert.  

8. To add a hyperlink, place your insertion point where you want the link 

to appear in the signature text, click on the Insert Hyperlink button, 

browse to a hyperlink, click to select it, and then click OK. 

9. The following steps are optional.  

a. You can now choose the email account and the message types to associate the 

signatures with. Under Choose default signature in the top-right corner of the 

dialog select an email account using the drop-down selector beside E-mail 

Account. (If you only have one email account it will be selected already.) 

b. In the New messages list if you want a signature to be inserted automatically in 

each message that is sent from the e-mail account that you chose, select a 

signature in the list. If you do not want a signature to be inserted automatically in 

each message that is sent, select none in the list. 

Picture 

Hyperlink 
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c. If you want to include a signature in message replies and in forwarded messages, 

in the Replies/forwards list, select a signature. If not, select none. 

10. After you finish creating the signature, click on OK. 

To insert a signature manually in a message 

1. In a new mail message position the insertion point where the signature is to appear. 

2. Select the Message tab of the Ribbon, and in the Include group click on the Signature 

button.  

3. Select the relevant signature to insert from the drop-down menu. 

To edit an existing signature 

1. Either, 

 Select the File tab in the Ribbon then click on Options. Select the Mail category in the 

left-hand panel and in the Compose messages section, click on the Signatures button. 

 Or, in a new mail message select the Message tab of the Ribbon, and in the Include 

group click on the Signature button. Then select Signatures... from the drop-down 

menu. 

2. The Signatures and Stationery dialog is displayed. 

3. Select the signature from the top-left box. 

4. Make your required changes then click on OK. 

To delete a signature 

1. Either, 

 Select the File tab in the Ribbon then click on Options. Select the Mail category in the 

left-hand panel and in the Compose messages section, click on the Signatures button. 

 Or, in a new mail message select the Message tab of the Ribbon, and in the Include 

group click on the Signature button. Then select Signatures... from the drop-down 

menu. 

2. The Signatures and Stationery dialog is displayed. 

3. Select the signature from the top-left box. 

4. Click on the Delete button and confirm the deletion. 

5. Click on OK or Cancel to close the dialog - cancel has no effect as the deletion has 

already been confirmed. 

Electronic Business Card 

Electronic Business Cards make sharing contact information easier. They can quickly be inserted into 

messages that you send and are immediately recognizable by the recipient. You can also forward the 

cards or include your card in a signature that is automatically included in outgoing messages. In each 

case, in an HTML-based message, the person who receives your message gets a visible identifier to 

quickly save as a contact. 

How people see an Electronic Business Card depends on their email software: 

Sam
ple



 

2017 Chris Page 

6 

 People who use Outlook 2007 or later see the Electronic Business Card in the message, 

represented just as you sent it. The recipient can right-click the card and save the information to 

Outlook Contacts. 

 People with earlier versions of Outlook or other e-mail applications who use HTML to view e-

mail also see the Electronic Business Card in their message. These cards are images only, 

however. Recipients also receive an attached .vcf file that contains the card's information. They 

can open the .vcf file and save that information to their contact lists. 

 People who view their e-mail in plain text  won't see an image of the Electronic Business Card 

in the message, but they receive the .vcf file attachment, which contains the contact information 

that they can save to their contact lists. 

Each contact in your Contacts list has a default Electronic Business Card. You would need to create a 

contact entry for yourself to create a business card for yourself. Once a card is created it can be edited. 

To edit an Electronic Business Card 

1. In People make sure you are using any view other than People (such as Card or List). 

2. Double-click on the contact entry name to open it. 

 

3. The default card is displayed in the top-right corner. 

4. If you would like to see a photograph on the card, then select the Contact tab of the 

Ribbon, and in the Options group click on the Picture button. Select Add Picture... then 

choose a suitable photograph. The new picture will beside your Name and Company 

details in the Contact record, and also on your card. To modify the picture, click on the 

Picture button again and select Change Picture... to change to a different picture, or 

Remove Picture... to return to the default graphic. 

  

Sam
ple



2017 Chris Page 

1 

EXERCISE 1  

 

 

1. Start Outlook 2016 if it is not already running. 

2. Create a new Contact Group called Sales Team consisting of: 

Student A 

Student B 

Student C 

3. Create a new Contact Group called Support Team consisting of: 

Student D 

Student E 

Student F 

   

4. Edit the Sales Team contact group and remove Student C, then add in Student D. 

5. Edit the Support Team contact group and remove Student D, then add in Student C. 
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EXERCISE 2  

1. Create a new contact record for yourself using the following details: 

Name:   Use your own name 

Company: Student Ltd 

Job Title: Sales Manager 

Business Tel: 0345 555777 

Business Fax: 0345 666888 

Email:  Use your course email address which is in the form ?@student.com 

where the ? is your student letter. 

Web page address: www.student.com 

 

2.  Modify the Electronic Business Card of this record so 

the layout looks the same as the card shown below 

(apart from the name and email address). For the logo 

use the file StudentLogo.jpg found in your PC's My 

Pictures folder. 

3. Close and save the changes to this new contact record. 

4. Now create a signature for yourself on your email 

account that looks like this below (again the name will be yours!) 

 

 

 

 

 

 

5. Make sure the signature is attached automatically to new messages and replies/forwards, then 

close and save the changes. 

6. Now create a new email. The signature should appear. Send this email to the student on your 

left. 

7. You will also receive an email from another student. Add their business card to your contacts 

by double-clicking on the vcf attachment. 
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